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FortiMail VM Overview

Welcome and thank you for selecting Fortinet products to protect your network.

The FortiMail VM Secure Messaging Platform (FortiMail VM) is part of an integrated hardware and software solution
that provides powerful and flexible antispam, antivirus, email archiving, logging, and reporting capabilities to
incoming and outgoing email traffic. FortiMail has reliable and high performance features for detecting and blocking
spam messages and malicious attachments. Built on Fortinet’s FortiOS™, FortiMail antivirus technology extends full
content inspection capabilities to detect the most advanced email threats.

This guide assumes that the reader has an understanding of virtualization servers.

Licensing

When you buy FortiMail VM, Fortinet sends a registration number to the email address supplied on the order form.
Use that number to register with Fortinet Support (support.fortinet.com) and to obtain a license file (.lic file
extension). You need the license file to activate FortiMail VM and unlock the full range of features, such as the
maximum virtual memory and number of CPUs.

FortiMail VM includes a 15-day trial (VM00). The trial version provides all FortiMail VM functions except antispam and
antivirus signature updates and the FortiGuard Antispam query, which requires a valid service contract. Because the
trial version only provides low encryption, you may not be able to access the FortiMail VM GUI through HTTPS, unless
you have enabled weak ciphers in your browser. The trial period begins the first time you start FortiMail VM. If you do
not install a valid license before the trial period or your license expires, you will not be able to make configuration
changes to FortiMail VM.

To validate the license, FortiMail VM must be able to connect to Fortinet servers on the Internet. See also the
FortiMail required open port numbers.

Fortinet provides several licenses for FortiMail VM: a 1-CPU license (VM01), a 2-CPU license (VM02), a 4-CPU license
(VM04), an 8-CPU license (VM08), a 16-CPU license (VM16), and a 32-CPU license (VM32). You can install your full
license from Fortinet Support at any time during or after the trial period. For details about how to install or update a
license, see Installing the FortiMail VM license on page 47.

Resources

The following table shows the resources available with each FortiMail VM license.

VM00 VM01 VM02 VM04 VM08 VM16 VM32

Maximum Virtual CPUs
Supported

1 1 2 4 8 16 32
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FortiMail VM Overview

VM00 VM01 VM02 VM04 VM08 VM16 VM32

Virtual NICs
(Minimum/Maximum)

1/4 1/4 1/4 1/6 1/6 1/6 1/6

Virtual Machine Storage
(Minimum/Maximum)

50 GB/1
TB

50 GB/1
TB

50 GB/2
TB

50GB/4
TB

50GB/8
TB

50GB/12
TB

50GB/24
TB

Virtual Machine Memory
(Minimum/Maximum)

1GB/2
GB

1GB/6
GB

1GB/8
GB

1GB/16
GB

1GB/64
GB

1GB/128
GB

1GB/128
GB

Most resources are available after successful deployment of the OVF file and validation of the license file. See
Deploying the FortiMail VM software on page 10 and Starting FortiMail VM on page 18.

To use more than one CPU, you must configure it when you deploy FortiMail VM. See Configuring the number of
CPUs on page 17.

You can reduce the size to as small as 5 GB. See Configuring a smaller disk on page 17.

Registering your Fortinet product

To obtain the FortiMail VM license file you must first register your FortiMail VM with Fortinet Customer Service &
Support.

To register your FortiMail VM:

1. Log in to the Fortinet Customer Service &Support portal using an existing support account or select Create an
Account to create a new account.

2. In the toolbar select Asset  > Register/Renew .

3. The Registration Wizard opens.

4. Enter the license registration code from the FortiMail VM License Certificate that was emailed to you and select
Next . The Registration Info page is displayed.

5. Follow the instructions to finish the registration.

6. In the Registration Completed page you can download the FortiMail VM license file. Select the License File
Download link. You will be prompted to save the license file (.lic) to your management computer. See Installing
the FortiMail VM license on page 47 for instructions on uploading the license file to your FortiMail VM via the GUI.

Downloading the FortiMail VM deployment
package

To download the FortiMail VM deployment package:

1. On the Fortinet Support site, go to Downloads > Firmware Images.

2. Select FortiMail

3. Click the Download tab.
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FortiMail VM Overview

4. Click the version number to open the folder.

5. Click HTTPS in the row to download the appropriate .zip file for your platform.

For supported platform versions, see the FortiMail Release Notes.

VM Platform FortiMail VM Deployment File

Citrix XenServer FML_VMXE-64-vXXX-buildnnnn-FORTINET.out.xenserver.zip

OpenXen FML_VMOC-64-vXXX-buildnnnn-FORTINET.out.openxen.zip

Microsoft Hyper-V Server FML_VMHV-64-vXXX-buildnnnn-FORTINET.out.hyperv.zip

KVM (qemu) FML_VMKV-64-vXXX-buildnnnn-FORTINET.out.kvm.zip

VMware ESXi FML_VM-64-vXXX-buildnnnn-FORTINET.out.ovf.zip

OpenStack FML_VMKV-64-vXXX-buildnnnn-FORTINET.out.kvm.zip

Deployment package contents

Deployment package contents varies by the supported platform.

Platform FortiMail VM Package Contents

Citrix XenServer l fortimail-vm-xen.vhd and nnn.vhd files: FortiMail system hard disk in
VHD format, where nnn is the size of the disk in gigabytes (GB), such as
250.vhd for a 250 GB disk.

l fortimail-vm-xen-xxxgb.ovf: Open Virtualization Format (OVF)
template file, containing virtual hardware settings.

Microsoft Hyper-V l fortimail-hv.vhd and nnngb.vhd: FortiMail system hard disk in VHD
format, where nnn is the size of the disk in gigabytes (GB), such as
250gb.vhd.

KVM and OpenStack l fortimail-kvm.qcow2: and nnngb.qcow2 files: FortiMail system hard
disk in QCOW2 format, where nnn is the size of the disk in gigabytes (GB),
such as 250gb.qcow2 for a 250 GB disk.

VMware ESXi l fortimail-vm-64bit-hw14.ovf: Open Virtualization Format (OVF)
template file, containing virtual hardware settings. hw14 indicates ESXi 6.7

l fortimail-vm-disk1.vmdk and fortimail-vm-disk2-nnngb.vmdk:
FortiMail system hard disk in VMDK format, where nnn is the size of the
disk in gigabytes (GB), such as fortimail-vm-disk2-250gb.vmdk for a
250 GB disk.

See also the list of VMware products and their corresponding virtual machine
hardware versions.
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FortiMail VM Overview

Deploying the FortiMail appliance

Prior to deploying the FortiMail appliance, the VM platform must be installed and configured so that it is ready to
create virtual machines. For details, see your VM platform's documentation. The deployment chapters in this
document are examples because for each hypervisor, there are multiple ways to create a virtual machine: command
line tools, APIs, GUI tools, etc.

Before you start your FortiMail appliance for the first time, you might need to adjust virtual disk sizes and networking
settings.

The first time you start FortiMail, you will have local console CLI access only through the console window of your VM
server environment. After you configure one FortiMail network interface with an IP address and administrative
access, you can access the FortiMail GUI.
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Deployment example: VMWare

Once you have downloaded the install file and extracted the package contents to a folder on your local computer,
you can use the vSphere client to create the virtual machine from the deployment package OVF template.

This section contains the following topics:

l Deploying the FortiMail VM software on page 10
l Configuring virtual network settings on page 14
l Starting FortiMail VM on page 18

Deploying the FortiMail VM software

To install FortiMail VM, you must successfully deploy the OVF file using the VMware vSphere Client™.

To deploy the software

1. Start the VMware vSphere Client.
The client’s login dialog appears.

2. Enter:
l the IP address of the ESXi server hosting VMware vSphere Hypervisor
l an account user name on the ESXi server
l the account password

When you successfully log in, the vSphere Client window appears.
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Deployment example: VMWare

3. On the vSphere Client window, select File > Deploy OVF Template.
The first dialog of the OVF deployment wizard appears.

4. Select Browse and locate the applicable OVF template file you extracted earlier (for example, FortiMail VM-64-
hw7.ovf), and click Next .

5. The second dialog displays the details of the deployed file. Click Next .
A window appears and prompts for the name of your OVF template.
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Deployment example: VMWare

6. Enter a unique name and click Next . This becomes the name of your virtual machine.
A window appears asking where to deploy the OVF template.

7. Select a resource pool and click Next .
A windows appears asking for the disk storage format.
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Deployment example: VMWare

8. Select a format option and click Next .
A window appears asking which network to deploy on.

9. Select a virtual network if there is more than one and click Next .

10. A window appears listing all your settings. Click Finish.
The wizard closes.

The vSphere Client window reappears and displays your new virtual machine.
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Deployment example: VMWare

Do not power on FortiMail VM yet if you need to configure the virtual network first.

Configuring virtual network settings

Before you power on FortiMail VM, you may need to set the number of virtual CPUs or configure the virtual network
to support your implementation of transparent mode for FortiMailVM.

This section includes:

l Preparing for transparent mode on page 14
l Configuring the number of CPUs on page 17
l Configuring a smaller disk on page 17

When you deploy the FortiMail VM OVF file, one virtual network interface card (vNIC) is automatically mapped to a
port on the ESXi server. You can change the mapping, or map other vNICs if required. Each vNIC has its own MAC
address and one or more IP addresses.

For more information, see the VMware vSphere documentation.

Preparing for transparent mode

If you plan to use transparent mode with your FortiMail VM installation, you need to:

l Set promiscuous mode. See To set promiscuous mode on page 15.
l Modify the network adapter configuration. See To modify a network adapter on page 16.

An ESXi server always has at least one vSwitch. For transparent mode, you need at two vSwitches, one to connect
FortiMail VM to the network and one to connect it to the mail server.

Add an additional vSwitch if necessary.
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Deployment example: VMWare

The following example of vSwitch creation shows connection to a virtual mail server hosted
on the same ESXi server. For a physical mail server, you need to connect to a physical NIC.

To add a virtual switch

1. Log in to the vSphere Client.

Do not power on FortiMail VM yet.

2. Select the host IP at the top of the left navigation pane.

3. On the Configuration tab, select Networking.

A window with information similar to the image below appears.

4. Select the Virtual Switch view and click Add Networking.

5. Accept the default connection type, Virtual Machines, and click Next .

6. Select Create a virtual switch and click Next .

7. Under Port Group Properties, enter a network label that identifies the port group to create.

8. Click Finish.

To set promiscuous mode

1. On the Configuration tab, select Networking.

2. For each virtual switch, select Properties.
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Deployment example: VMWare

3. On the Ports tab, click Edit .

4. Select the Security tab.

5. Select Accept from the drop-down list for Promiscuous Mode.

The setting on the port group overrides the virtual switch setting.

Next, you need to link a FortiMail VM network adapter to each new vSwitch.

To modify a network adapter

1. Select your FortiMail VM machine in the left navigation pane.

2. On the Getting Started tab, select Edit Virtual Machine Settings.

3. On the Hardware tab, select a network adapter from the hardware list.

4. Select the new vSwitch from the Network label drop-down list.

5. Click OK.
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Deployment example: VMWare

Later, configure the applicable FortiMail VM port or ports using the GUI. See FortiMail Administration Guide.

Configuring the number of CPUs

You may have more than one CPU depending on the type of license you purchased. By default, FortiMail VM is set to
one CPU. You can change the number of CPUs that the virtual machine uses by changing the number of virtual
processors (you cannot change the CPU setting while FortiMail VM is running).

To change the number of CPUs

1. Make sure FortiMail VM is not running.

2. Go to the Hardware tab.

3. Select CPUs in the hardware list.

4. In the CPUs drop-down list, select the number of virtual processors for the virtual machine.

5. Click OK.

Maintaining license limits

If you set the number of CPUs or memory beyond your license limit, your FortiMail VM license becomes invalid. To
determine if you have exceeded license limits, use the following CLI command:

get system status

If so, use the vSphere Client to restore valid settings.

Configuring a smaller disk

FortiMail VM comes prepackaged with a 1 TB disk. An alternate configuration with a 250 GB disk is provided for
installing in a VMware datastore that does not support a 1 TB disk.

If neither of these sizes suits your resources, you can configure FortiMail VM to support a disk size as small as 50 GB.
You can even configure the virtual disk to as small as 5 GB. The FortiMail VM system will still be able to start up with
warnings. However, the system will not start up if the virtual disk is smaller than the 5 GB minimum size.

To reduce the disk size

1. Stop FortiMail VM if it is running.

2. Log in to the vSphere Client.

3. On the Hardware tab, select either the 250 GB or 1 TB disk (Hard Disk 2) in the hardware list.

4. Click Remove.

5. Click OK.

6. Click Add and select Hard Disk.

7. Configure the new disk.

The Virtual Device Node setting must be SCSI (0:1).

8. Complete the disk configuration and click OK.
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Deployment example: VMWare

9. Start the FortiMail VM.

If FortiMail VM was previously run, you need to manually initialize this new disk.

10. Log in as the administrator and run the CLI command:
execute partitionlogdisk 10

Starting FortiMail VM

Once you successful deploy the OVF file and set up the network (if required), you need to power on your FortiMail VM
virtual appliance and enter initial setup commands.

To power on FortiMail VM

1. Log in to the vSphere Client.

2. Select your newly deployed FortiMail VM virtual machine in the left navigation pane of vSphere Client and power
it on.
There are several ways to power on a virtual machine. The easiest is to click the green triangle icon on the icon
bar.

3. Select the Console tab in the vSphere Client window.
When you power on the virtual appliance, the console displays a sequence of messages ending in a login
prompt.

At this point, you have accessed the FortiMail VM command line interface (CLI) but you
do not have access to all CLI commands until you confirm the license in a later step.

4. Press the Enter key once to get a new prompt, and log in using the default FortiMail VM administrator name,
admin.
There is no password yet for this administrator. Press Enter when prompted.

You will see a welcome message.

5. Use CLI commands to configure the IP address of a virtual interface (usually port1) on the virtual appliance to use
for administrative access.
You will later access the FortiMail VM GUI through a browser at this IP.

Enter the following CLI commands in the vSphere Client console:
config system interface
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Deployment example: VMWare

edit <port_name>
set ip <address_ipv4mask>

end
Where:
l port_name is the name of the FortiMail VM virtual port (usually port1)
l ipv4-mask is the IP (with a netmask) of your virtual machine on the ESXi server

Take note of the IP you enter. Later, you will use that IP, minus the netmask, to
configure and manage FortiMail VM through the CLI or GUI.

6. Use CLI commands to configure a static route to act as a default gateway. This is needed for license updates.
Enter the following CLI commands in the vSphere Client console:
config system route

edit <route_index>
set gateway <gateway_ipv4>

end
Where:
l <index_int> is the index number, such as 1, of the route in the list of static routes
l <gateway_ipv4> is the IP address of the gateway router

To log on to the FortiMail VM GUI

When you successfully configure administrative access, the GUI login dialog may appear automatically if you have a
browser open.

If not, open a web browser and enter a URL that includes the IP address of the virtual interface your set in step 5. For
example:

https://192.168.1.99/admin

FortiMail VM start-up settings:

Web-based administrator URL https://<virtual-ipaddress>/admin

Administrator account admin

Administrator password none

Management access HTTPS, SSH, ping

Operation mode gateway mode

Webmail URL https://<virtual-ipaddress>

If you are connecting to FortiMail VM with a trial license or a LENC version of FortiMail, you
may not be able to see the logon page due to an SSL cipher error during the connection. In
this case, you must configure the FortiMail interface to allow HTTP connections and access
it with HTTP only.

config system interface
edit port1

set allowaccess http
end
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Deployment example: VMWare

1. On the logon page, in Name, enter admin.

2. Skip the Password field (until you assign the admin a password later).

3. Click Logon.

The FortiMail GUI opens at the dashboard. Notice the VM status in the License Information widget.

Installing the license

If you have a FortiMail VM license (for details, see Licensing on page 6), you can install it now after you start up
FortiMail VM.

To install the license

1. In the License Information widget on the FortiMail VM GUI, click the Update link to the right of VM.

2. Locate and select the license file (.lic file extension) that you downloaded earlier from Fortinet.

3. Click Open.
A message box appears stating your license is being authenticated. This may take a few minutes.

If you uploaded a valid license, a second message box will appear informing you that your license authenticated
successfully.
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Deployment example: VMWare

4. Click OK on the message box.
The system will reload and log out.

5. Log in again if prompted using admin, as the user name.

Congratulations! You have successfully installed FortiMail VM and can now configure your virtual appliance.
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Deployment example: Hyper-V

Once you have downloaded the .hyperv.zip file and extracted the package contents to a folder on your Microsoft
server, you can deploy the VHD package to your Microsoft Hyper-V environment.

Creating the FortiMail VM virtual machine

To create the FortiMail VM virtual machine:

1. Launch the Hyper-V Manager in your Microsoft server.
The Hyper-V Manager home page opens.

2. Select the server in the right- tree menu. The server details page is displayed.

3. Right-click the server and select New and select Virtual Machine from the menu. Optionally, in the Actions
menu, select New and select Virtual Machine from the menu.
The New Virtual Machine Wizard opens.

4. Select Next to create a virtual machine with a custom configuration.
The Specify Name and Location page is displayed.

5. Enter a name for this virtual machine. For example, FortiMail-VM. The name is displayed in the Hyper-V Manager.

6. Select Next to continue. The Assign Memory page is displayed.

7. Specify the amount of memory to allocate to this virtual machine. The default memory for FortiMail VM is 2GB
(2048MB).
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Deployment example: Hyper-V

8. Select Next to continue. The Configure Networking page is displayed.
Each new virtual machine includes a network adapter. You can configure the network adapter to use a virtual
switch, or it can remain disconnected. FortiMail VM requires four network adapters. You must configure network
adapters in the Settings page.

9. Select Next to continue. The Connect Virtual Hard Disk page is displayed.

10. Select to use an existing virtual hard disk and browse for the fortimail-hv.vhd file that you downloaded from
the Fortinet Customer Service &Support portal.

11. Select Next to continue. The Summary page is displayed.

12. To create the virtual machine and close the wizard, select Finish.

Configuring FortiMail VM hardware settings

Before powering on your FortiMail VM you must configure the virtual CPU, and create network adapters and virtual
disk configuration to match your FortiMail VM license. See Licensing on page 6 for FortiMail VM license information.

FortiMail VM does not currently support UEFI boot (in other words, it is not a 2nd generation virtual machine).

Configure the FortiMail VM hardware settings prior to powering on the FortiMail VM.

To configure settings for FortiMail VM on the server:

1. In the Hyper-V Manager, locate the name of the virtual machine, right-click the entry, and select Settings from
the menu. Optionally, you can select the virtual machine and select Settings in the Actions menu.

The Settings page is displayed.
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Deployment example: Hyper-V

2. Configure virtual processors, network adapters, and virtual hard drive settings.

3. Select Apply to save the settings and then select OK to close the settings page.

FortiMail VM virtual processors

You must configure FortiMail VM virtual processors in the server settings page. The number of processors is
dependent on your server environment.

Configure FortiMail VM virtual processors:

1. In the Settings page, select Processor from the Hardware menu.
The Processor page is displayed.

2. Configure the number of virtual processors for the FortiMail VM virtual machine. Optionally, you can use resource
controls to balance resources among virtual machines.

3. Select Apply to save the settings.
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Deployment example: Hyper-V

FortiMail VM network adapters

You must configure FortiMail VM network adapters in the server settings page. FortiMail VM supports four network
adapters.

Configure FortiMail VM network adapters:

1. In the Settings page, select Add Hardware from the Hardware menu, select Network Adapter in the device list,
and select the Add button.
The Network Adapter page is displayed.

2. You must manually configure four network adapters for FortiMail VM in the settings page. For each network
adapter, select the virtual switch from the drop-down list.

3. Select Apply to save the settings.

FortiMail VM virtual hard disk

You must configure the FortiMail VM virtual hard disk in the server settings.

FortiMail VM requires at least two virtual hard disks. Before powering on the FortiMail VM,
add at least one more virtual hard disk. The default hard drive, fortimail-hv.vhd, contains
the operating system. The second hard drive will be used for logs and mail data.
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Deployment example: Hyper-V

If your environment will expand in the future, add hard disks larger than the 250 GB FortiMail
VM base license requirement. This will allow your environment to expand yet not take more
space in the SAN than is needed.

FortiMail VM allows for up to 12 virtual log disks to be added to a deployed instance. To use
the logical volume manager (LVM) to extend the disks, see the FortiMail CLI Reference.

Create a FortiMail VM virtual hard drive:

1. In the Settings page, select IDE Controller 1 from the Hardware menu.

2. Select Virtual Hard Disk.

3. Select Browse and select the .vhd file that matches your license.

4. Select OK.

Starting FortiMail VM

You can now proceed to power on your FortiMail VM. Select the name of the FortiMail VM in the list of virtual
machines, right-click, and select Start in the menu. Optionally, you can select the name of the FortiMail VM in the list
of virtual machines and select Start in the Actions menu.
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Deployment example: KVM

Once you have downloaded the install file and extracted the package contents to a folder on your local computer,
you can create the virtual machine in your KVM environment.

This section contains the following topics:

l Creating the FortiMail virtual machine on page 27
l Configuring FortiMail hardware settings on page 28
l Starting FortiMail VM on page 28

Creating the FortiMail virtual machine

To create the FortiMail virtual machine:

1. Launch Virtual Machine Manager (virt-manager) on your KVM host server.
The Virtual Machine Manager home page opens.

2. In the toolbar, select Create a new virtual machine.

3. Enter a Name for the VM, FortiMail-VM for example.

4. Ensure that Connection is localhost (this is the default.)

5. Select Import existing disk image.

6. Select Forward.

7. In OS Type select Linux.

8. In Version, select Generic 2.6 and later kernel.

9. Select Browse.

10. If you copied the fortimail-kvm.qcow2 file to /var/lib/libvirt/images, it will be visible on the right. If you
saved it somewhere else on your server, select Browse Local and find it.

11. Select Choose Volume.

12. Select Forward.

13. Specify the amount of memory and number of CPUs to allocate to this virtual machine. The amounts must not
exceed your license limits. See “Resources” on page 4.

14. Select Forward.

15. Expand Advanced options. A new virtual machine includes one network adapter by default. Select a network
adapter on the host computer. Optionally, set a specific MAC address for the virtual network interface. Set Virt
Type to virt io and Architecture to qcow2.

16. Select Finish.
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Configuring FortiMail hardware settings

Before powering on your FortiMail you must add the storage disk and configure the virtual hardware of your FortiMail.

To configure settings for FortiMail on the server:

1. In the Virtual Machine Manager, locate the name of the virtual machine and then select Open from the toolbar.

2. Select Add Hardware. In the Add Hardware window select Storage.

3. Browse to the storage disk file that matches your licence, for example, 250.qcow2 (250 GB storage space) and
click OK.

4. Select Network to add more network interfaces. The Device type must be Virt io.
A new virtual machine includes one network adapter by default. You can add more through the Add Hardware
window. FortiMail requires four or six network adapters (see Resources on page 6). You can configure network
adapters to connect to a virtual switch or to network adapters on the host computer.

5. Select Finish.

Starting FortiMail VM

You can now proceed to power on your FortiMail. Select the name of the FortiMail in the list of virtual machines. In the
toolbar, select Console and then select Start .
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Once you have downloaded the install file and extracted the package contents to a folder on your local computer,
you can create the virtual machine in your Citrix XenServer environment.

This section contains the following topics:

l Creating the FortiMail VM virtual machine (XenCenter) on page 29
l Configuring virtual hardware on page 34

Creating the FortiMail VM virtual machine
(XenCenter)

To create the FortiMail virtual machine from the OVF file

1. Launch XenCenter on your management computer.
The management computer can be any computer that can run Citrix XenCenter, a Windows application.

2. If you have not already done so, select ADD a server. Enter your Citrix XenServer IP address and the root logon
credentials required to manage that server.
Your Citrix XenServer is added to the list in the left pane.

The Virtual Machine Manager home page opens.

3. Go to File > Import . An import dialog will appear.

4. Click the Browse button, find the FortiMail .ovf template file, then click Open.
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5. Select Next .

6. Accept the FortiMail Virtual Appliance EULA, then select Next .
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7. Choose the pool or standalone server that will host the VM, then select Next .

8. Select the storage location for FortiMail disk drives or accept the default. Select Next .

9. Configure how each vNIC (virtual network adapter) in FortiMail will be mapped to each vNetwork on the Citrix
XenServer, then click Next .
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10. Click Next to skip OS fixup.

11. Select Next to use the default network settings for transferring the VM to the host.
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12. Select Finish.

The Citrix XenServer imports the FortiMail files and configures the VM as specified in the OVF template. Depending
on your computer’s hardware speed and resource load, and also on the file size and speed of the network
connection, this might take several minutes to complete.
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When VM import is complete, the XenCenter left pane includes the FortiMail in the list of deployed VMs for your Citrix
XenServer.

Configuring virtual hardware

Before you start your FortiMail VM for the first time, you can optionally adjust your virtual machine’s virtual hardware
settings to meet your network requirements.

Configuring number of CPUs and memory size

Your FortiMail VM license limits the number CPUs and amount of memory that you can use. The amounts you allocate
must not exceed your license limits. See Licensing on page 6.

To access virtual machine settings

1. Open XenCenter.

2. Select your FortiMail VM in the left pane.
The tabs in the right pane provide access to the virtual hardware configuration. The Console tab provides
access to the FortiMail console.

To set the number of CPUs

1. In the XenCenter left pane, right-click the FortiMail VM and select Properties.
The Properties window opens.

2. In the left pane, select CPU.
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3. Adjust Number of CPUs and then select OK.
XenCenter will warn if you select more CPUs than the Xen host computer contains. Such a configuration might
reduce performance.

To set memory size

1. In the XenCenter left pane, select the FortiMail VM.

2. In the right pane, select the Memory tab.

3. Select Edit , modify the value in the Set a fixed memory of field and select OK.
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FortMail VM supports cloud- init integration, allowing cross-platform cloud instance initialization. Cloud- init for
FortiMail places all of its config data in OpenStack, or a content directory.

OpenStack-based clouds provide the environment needed for elastic, on-demand multitenant applications.
Networks are transitioning to new models more suited to the cloud with SDN, NFV, and Virtual Network
Infrastructure, and their relationships between networking, security orchestration, and policy enforcement.

You can install FML-VMKV (KVM) firmware into an OpenStack environment.

This section contains the following topics:

l Overview on page 1
l Deploying FortiMail VM in OpenStack on page 39

Overview

FortiMail VM looks for three configuration files to apply:

l mode: CLI command that has the system mode configured (i.e. Gateway, Server, or Transparent).
It is recommended to set the mode before any configuration, as setting the mode effectively factory resets the
system.

Note that some configuration options are only available in certain modes.
l config: Any other CLI configuration that apply to the system after the mode is set.
l license: The VM license file.

Any combination of these configuration files (or none) may be provided.

The license file is a typical VM license (.lic) file. Below are some samples of what might be in the mode and config
files:

The mode text file:

config system global
set operation-mode server

end

The config text file:

config system interface
edit port1

set ip 172.20.140.250/24
set allowaccess https ping ssh telnet

next
end

config system dns
set primary 8.8.8.8
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set secondary 4.4.4.4
end

config system route
edit 1

set gateway 172.20.140.2
next

end

config system admin
edit fmltest

set access-profile super_admin_prof
set password 123456

next
end

Bootup the instance

To bootup a FortiMail VM instance, OpenStack can use something similar to the following command (in this example,
using nova boot):

nova boot --flavor FML_small --image fml_image --file license=FEVM010000041191.lic --file
config=fmlinit.txt --file mode=fmlmode.txt fml_instance

In this example the system will reboot twice: after loading mode and then after loading a
new license.

Without OpenStack

Without OpenStack you would need to place all necessary configuration files in the Windows content directory. For
example:

1. Place the configuration files in:
openstack/content/0000 (for example the "mode" file)

openstack/content/0001 (for example the "config" file)

openstack/content/0002 (for example the 'license' file)

Any combination of these may be present.

2. Create or update the openstack/latest/meta_data.json file to point to these files:
{"files": [
{"path": "mode", "content_path": "/content/0000"},
{"path": "config", "content_path": "/content/0001"},
{"path": "license", "content_path": "/content/0002"}
]}
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Deploying FortiMail VM in OpenStack

The VMware management software, in this case OpenStack Horizon, is installed on a computer with network access
to the OpenStack server.

Once you have access to the OpenStack dashboard, configure the following steps to launch a FortiMail VM instance.

An Internet connection is required for the FortiMail VM to contact FortiGuard to validate its
license. If the FortiMail VM is in a closed environment, it must be able to connect to a
FortiManager to validate the FortiMail VM license.

Creating the flavor

1. In the OpenStack dashboard, go to Admin > Compute > Flavors and click Create Flavor.

2. Under Flavor Information, define the parameters for FortiMail VM instance deployments.
Make sure to set the following minimum requirements:
l VCPUs: 1
l RAM: 1024MB
l Root Disk: 2GB
l Ephemeral Disk: 55GB

3. Click Flavor Access, and add the projects you wish to have access to this flavor. In this case, the current project
is selected (admin).
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4. Click Create Flavor.

Creating the image

1. Go to Admin > Compute > Images and click Create Image.
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2. From the Image Details tab, under Image Source > File, click Browse.

3. Select the image file downloaded from the Fortinet Customer Service & Support portal.
The image file name is:

fortimail-kvm.qcow2

4. Set Format to QCOW2 - QEMU Emulator.

5. Optionally, click the Metadata tab and assign any necessary metadata definitions.
Selecting each option opens a dropdown menu showing what is included for each metadata resource and their
descriptions below.

6. When finished, click Create Image.
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Launching the instance

1. Go to Project > Compute > Instances and click Launch Instance.

2. Under the Details tab, enter an Instance Name and an optional Description, define the Availability Zone where
the instance will be deployed, and the instance Count , in cases where you require multiple instances with the
same settings.

3. Click Next .

4. Under the Source tab, set Select Boot Source to Image. By default, Create New Volume is set to Yes. Increase
the Volume Size as required.

5. Upload the image created earlier from under the Available list by clicking the icon.
The image is moved to the Allocated list as shown in the following example:

6. Click Next .
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7. Under the Flavor tab, select the Flavor created earlier by moving it from the Available list to the Allocated list.

8. Click Next .

9. Under the Networks tab, define whether the instance should be located on a public, private, or shared network.

10. Optionally, continue configuring the remaining tabs. When finished, click Launch Instance.

The newly created FortiMail VM instance is launched.

Accessing instance console

You can access your list of instances from under Project > Compute > Instances.

1. If you haven't already, launch an instance by selecting Start Instance from the Actions column.
The Power State column will show that the instance is powering on.

After a few seconds, the instance will show a Power State of Running.

2. To access the instance's console, click the Actions drop-down menu and select Console.
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You are redirected to the Instance Console.

If you just started the instance, you may need to wait a few minutes for the instance initialization to complete.

3. Once it is complete, you can login to the FortiMail VM.
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Initial configuration

Before you can connect to the FortiMail VM GUI you must configure the FortiMail VM basic configuration via the CLI
console. Once configured, you can connect to the FortiMail VM GUI and upload the FortiMail VM license file that you
downloaded from the Customer Service &Support portal.

This section contains the following topics:

l FortiMail VM console access on page 46
l Connecting to the FortiMail VM GUI on page 47
l Installing the FortiMail VM license on page 47
l Configuring your FortiMail VM on page 48
l FortiMail VM backup on page 48

FortiMail VM console access

To enable GUI access to the FortiMail VM you must configure the port1IP address and network mask of the FortiMail
VM.

To configure the port1 IP address and netmask:

1. In the list of virtual machines, select the FortiMail VM that you deployed, right-click, and select Connect from the
menu.
The Console window appears
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2. At the FortiMail VM login prompt enter the user name admin and password. The default password is no
password.

3. To configure the port1IP address and netmask, enter the following CLI commands:
config system interface

edit port1
set ip <ip-address-netmask>

end

The port management interface should match the first network adapter and virtual switch
that you have configured in the Microsoft Hyper-V Server virtual machine settings.

The Customer Service &Support portal currently does not support IPv6 for FortiMail VM
license validation. You must specify an IPv4 address in both the support portal and the port
management interface.

Connecting to the FortiMail VM GUI

Once you have configured the port1IP address and network mask, launch a web browser and enter the IP address
you configured for the port management interface. At the login page, enter the user name admin and password and
select Login. The default password is no password. The GUI will appear with an Evaluation License dialog box.

By default, the GUI is accessible via HTTPS.

Installing the FortiMail VM license

Every Fortinet VM includes a 15-day trial license. During this time the FortiMail VM operates in evaluation mode.

Before using the FortiMail VM you must activate it by installing a valid license.

Depending how your FortiMail VM is licensed, there two ways to you can install the license and activate the VM:

l If you get the license file from Fortinet Customer Service &Support portal upon registration, you can install it as
described below.

l Starting from v7.6.2, FortiMail supports FortiFex tokens. FortiFlex (formerly Flex-VM) is a subscription service to
configure and manage VM usage entitlements. Subscribers can create multiple sets of a single VM entitlement
that corresponds to a licensed virtual machine. Each entitlement contains a base VM and one service bundle.
Usage entitlements require a unique token to be installed on every VM. Once the VM configurations are defined
and VM entitlements are created in the FortiFlex portal, a token is also generated. For details, see the FortiFlex
documentation. Then you can enter the token as described below.
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To install the license file or FortiFlex token

1. In the License Information widget on the FortiMail VM GUI, click the Update link to the right of VM.

2. For Activation type, select License File to install a license file, or select FortiFlex Token to install a token.

3. To install a license file, select [Choose File..., locate and select the license file (.lic) you downloaded earlier from
Fortinet, and selectOpen.
A message box appears stating your license is being authenticated. This may take a few minutes.

If you uploaded a valid license, a second message box will appear informing you that your license authenticated
successfully.

4. To install a FortiFlex token, enter the token you copied from the FortiFlex portal

5. Click OK.
The system will reload and log out.

6. Log in again if prompted using admin, as the user name. The VM registration status appears as valid in the
License Information widget once the license has been validated.

After an invalid license file or FortiFlex token is loaded to FortiMail VM, the GUI will be
locked until a valid license or token is uploaded.

Configuring your FortiMail VM

Once the FortiMail VM license has been validated you can begin to configure your device. For more information on
configuring your FortiMail VM, see the FortiMail Administration Guide.

FortiMail VM backup

In VM environments, we recommend that you use the Snapshot utility to back up the VM instance. In the event of an
issue with upgrading or configuring firmware, you can use snapshots to revert the VM instance to a previous
snapshot.
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